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Chapter 1

Introduction

This manual provides a general introduction to numerical scarp modeling, including the principles of tectonic
and geomorphic transport, a description of the basics of the numerical method used to solve the transport
equations, and a how-to guide for using the Penck1D graphical software in Matlab. The manual is organized
into three basic parts: an overview of the principle observations of regolith mantled and bedrock scarps
(Chapter 2) , the solution of the equations of displacements and di�usive geomorphic transport using the
Finite Di�erence Method (Chapter 3), and a how-to manual for using the software (Chapter 4). Finally, we
provide a brief discussion of the applications of the fault scarp modeling approach, its validity, and areas of
future research in this subject.

If you use Penck1D in your research, please acknowledge this document and the software development
documents as follows:

Hilley, G. E., and J R. Arrowsmith, Penck1D: Transport- and Production- limited fault scarp simulation
software, GSA Special Short Course Manual, 44 pp.

Hilley, G. E., Landscape development in tectonically active mountain belts using geologic and geomorphic ob-
servations, digital topography analysis, and numerical models, Ph.D. dissertation, Arizona State University,
194 pp.

In addition, please report any bugs to George Hilley at hilley@geo.uni-potsdam.de. Please send a reprint
of any publications to George Hilley (current address available through email request). Finally, please feel
free to improve upon the model and add features, but be sure to send me a copy of the improved software
so that I can post these improvements on the web for general use.

5



6 CHAPTER 1. INTRODUCTION



Chapter 2

Tectonic deformation and geomorphic
transport of regolith

2.1 Observations of alluvial and bedrock scarps

A fault scarp is a tectonic landform where the fault plane, or a zone of interconnected fault segments,
intersects the land surface [Stewart and Hancock, 1990]. Fault scarps may be formed by o�set of regolith or
bedrock. When bedrock is not exposed, the amount of sediment available for transport is larger than the
transport capacity of the geomorphic processes, and hence the scarp is transport-limited. However, once
bedrock is exposed, there may be excess transport capacity relative to the amount of transportable sediment.
In these cases, sediment cannot be transported until it is produced by bedrock weathering. Thus, bedrock
scarps are production-limited [Carson and Kirkby, 1972]. The morphology of transport-limited scarps is
controlled primarily by the rate at which material can be transported, whereas production limited scarp
morphology is controlled by the production rate of transportable material from bedrock.

The morphology of transport- and production-limited scarps is often markedly di�erent (Figure 2.1a
and b). Fresh transport-limited scarps show a steep face that is often dominated by mass failure, and
sometimes gullying. Usually these slopes are reduced to the internal angle of friction of the material soon
after rupture [Figure 2.1a; e.g., McCalpin, 1996]. This transport results in the deposition of colluvium at
the base of the scarp as the upper edge is bevelled (Figure 2.2a). Following degradation of the scarp by mass
failure, material in channels and gullies is transported by 
uvial processes, whereas local hillslope processes
transport material across the scarp in the inter
uves (Figure 2.2a). Where gullying and channelization are
not signi�cant, the scarp typically shows a smooth pro�le, with a convex-up form on the upper part of the
scarp and a concave-up form on the lower slopes of the scarp [e.g., Nash, 1980; Figure 2.1b). As faulting
continues, the scarp elevation and curvature is increased and the process is started anew.

Production-limited scarps do not display the smooth morphology typical of transport-limited scarps
(Figure 2.1c and d). These fault scarps are often expressed as bedrock cli�s that may show structural
kinematic indicators of motion along the fault. With time, the bedrock face of the scarp is converted to
regolith that is transported downslope into the colluvial pile at the base of the scarp (Figure 2.2b). Material
may also be transported to the base of the scarp by gravity failure along pre-existing mechanical weaknesses
such as fractures. In this process, rock topple and mass failure may act to degrade the scarp. Where these
processes are not signi�cant, the scarp can retain its steepness for long periods of time in places where the
production rate of transportable regolith from bedrock is low. Further movement along the fault acts to
increase the height of the bedrock scarp face. The isolation of transportable material at the top of the scarp
from the bottom may prevent slope steepening at the scarp face from accelerating the amount of sediment
moving to the base of the scarp. However, after su�cient time, the scarp is degraded as the bedrock is
converted to regolith and transported away from the high-slope areas.

7
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(a)

(c)

(b)

(d)

Figure 2.1: Degradation of transport-limited (a){(b) and production-limited (c){(d) scarps. (a) Following
rupture, transport-limited scarps form a steep linear pro�le whose angle is typically close to the angle of
repose of the material. (b) With time, geomorphic processes bevel the upper edge of the scarp and deposit
this material at its base. We consider in our analysis only those areas of the scarp located in the inter
uves.
(c) In contrast, rupture along production-limited faults exposes bedrock, creating a bedrock cli�. (d) After
movement along the fault ceases, the bedrock scarp degrades, reducing the scarp slopes. Photos taken at
(a) the Hebgen Lake fault scarp, MT (Cabin Creek locality) (b) a normal fault in the Carrizo Plain, CA, (c)
Della Tank graben, and (d) Babbitt Lake fault scarp, both in northern Arizona.
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Figure 2.2: Schematic �gure showing the development of (a) transport- and (b) production-limited scarps.
Topography and depositional patterns emphasize near-fault development. The lower �gures show the devel-
opment of the scarp after signi�cant time has passed.

2.2 Conceptual and numerical model of scarp degradation

To understand how active faults may be morphologically expressed, we built a model that relates the to-
pography to the tectonic and geomorphic processes that form fault scarps. Our general approach couples
constitutive equations that characterize tectonic deformation and geomorphic processes to the equations of
continuity (mass conservation) to numerically model scarp development over time. We limit our analysis
to the consideration of systems in which there are neither displacements nor geomorphic transport in the
out-of-plane dimension of a topographic pro�le of the scarp. This reduces the model to a one-dimensional
geomorphic transport model that is displaced by two-dimensional tectonic displacements.

2.2.1 Tectonic processes

In our tectonic model, we assume that the upper crust can be approximated by a brittle linear-elastic
rheology that deforms in response to slip along and opening of discontinuities in the medium. We model
fault-induced surface displacements by embedding a dislocation in an elastic half-space and letting it slip a
prescribed amount. The geometry of the fault can be expressed by two parameters| the fault dip, �, and
the down dip length of the fault surface, W . We assume that the fault is in�nitely long in the out-of-plane
dimension, and hence, deformation is approximated by plane-strain conditions (Figure 2.3a). The slip along
the fault is described by the Burgers vector (b). Positive and negative Burgers vectors on faults dipping to
the right indicates reverse and normal motion along the fault, respectively.

Given these three parameters, the surface displacements can be computed by summing the e�ects of
two opposing, in�nitely long edge dislocations starting at the upper (w1 in Figure 2.3a) and lower (w2

in Figure 2.3a) edges of the fault, respectively. The equations for relating surface displacements to fault
geometric parameters are [Du et al., 1994]:
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Figure 2.3: Model fault geometry and controlling parameters. (a) The surface displacements are computed
by summing the e�ect of slip along two in�nite dislocations extending downward (w1, w2), whose ends start
at (x1; y1) and (x2; y2), respectively. The hachured line is the free surface and the solid line is the idealized
fault. (b) The volume 
ux of sediment (Qs) moved downhill by geomorphic processes is proportional to the
local slope. Changes in elevation with time due to changes in Qs downslope are computed numerically. (c)
Regolith is produced from bedrock as an exponential function of regolith thickness. Production is maximum
at the surface (Ba) and decays according to the regolith thickness sensitivity, Bb.

Ux = � 1

�

�
bx tan

�1(d) +
bz � bxd

1 + d2

�
(2.1)

Uz =
1

�

�
bz tan

�1(d) +
bx + bzd

1 + d2

�
(2.2)

where, Ux is the horizontal displacement at the free surface (L),

Uz is the vertical displacement at the free surface (L),

bx is the horizontal component of the Burgers vector (L),

bz is the vertical component of the Burgers vector (L),

and d is the geometric parameter.

The geometric parameter locates the tip of the dislocation relative to the point of interest along the free
surface:

d =
(x� xn)

zn
(2.3)
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where x is the horizontal coordinate of the surface point of interest (L),

xn is the x coordinate of the tip of the nth dislocation (L),

and zn is the vertical coordinate of the tip of the nth dislocation (L).

Finally, the dip of the dislocation is de�ned by the magnitudes of the components of the Burgers vectors.
The components of the Burgers vector are related to the fault dip as, bx = b cos� and bz = b sin�.

Surface displacements are determined by summing the displacements Ux and Uz due to the two oppositely
oriented dislocations de�ning the slip patch. By repeating this calculation for many points along the surface,
we can determine the surface displacement �eld due to slip along the simulated fault. Although these
equations relate fault slip to surface displacement, they may also be used to compute surface displacement
rates by di�erentiating Equations 2.1 and 2.2 with respect to time.

2.2.2 Geomorphic processes

Geomorphic transport

Where channels, landsliding, aeolian transport, and glacial processes do not exist, the geomorphic surface
sediment transport rate is approximately proportional to the local slope angle [e.g., Davis, 1892; Gilbert,
1909; Culling, 1960; Koons, 1989; McKean et al., 1993; Small et al., 1999]. First, we use a linear di�usive
transport law that approximates the e�ects of bioturbation, rain splash, and sheet wash [e.g., Carson and
Kirkby, 1972]. In this formulation, the 
ux of material through a point along an unchannelized hillslope is
proportional to the local slope (Figure 2.3b):

Qs = ��
dH

dx
(2.4)

where, Qs is the volume 
ux of material moving through a point (L2/T),

� is the hillslope di�usivity (L2/T),

and H is the topographic elevation (L).

Next, continuity along the pro�le (mass conservation) requires that the change in the mass at each point
in a small amount of time is equal to the di�erence in the mass 
ux (Qm) entering and leaving that point:

@m

@t
=

dQm

dx
=

d(Qs�s(x; y; t))

dx
(2.5)

Assuming that the density of sediment does not signi�cantly change during transport, this mass 
ux can
be rewritten as the volume 
ux:

@H

@t
=

dQs

dx
(2.6)

By combining Equations 2.4 and 2.6, we can express the change in elevation over time at a point in terms
of the hillslope curvature:
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@H

@t
= ��r2H (2.7)

The hillslope di�usivity, � has been determined to be between 0.04 and 0.0004m2/yr [Fernandes and Dietrich,
1994, and references therein; Hanks, 2000] and may vary with climate, aspect, density of vegetation, and
other factors [e.g., Hanks, 2000].

Transport of material can only take place when there is su�cient sediment to transport. In the case
that @H=@t exceeds the thickness of transportable material over a given time increment, there is excess
transport capacity of the system relative to the available sediment. Therefore, the transport process erodes
all sediment available for transport, but fails to transport at full capacity. In the case that the transport
capacity exceeds available material, the 
ux of material moving downslope at points where these production-
limited conditions exist are computed by transporting only material that is available, H � B (where B is
the elevation of the bedrock (L)) and recomputing the 
uxes along the scarp:

Qs(x; y) =
H(x; y; t)�B(x; y; t)

@t
@x (2.8)

We iteratively recompute all 
uxes to calculate the change in elevation across parts of the landscape that
may be either transport- or production-limited.

Regolith production from bedrock

In general, it is assumed that bedrock is converted to regolith at a rate that decreases with increasing regolith
thickness [Ahnert, 1970; Carson and Kirkby, 1972; Heimsath et al., 1998; Heimsath et al., 1999; Small et
al., 1999]. This rate is thought to decay either exponentially [e.g., Heimsath et al., 1998; Heimsath et al.,
1999; Carson and Kirkby, 1972; Ahnert, 1970; Anderson and Humphrey, 1989] or as a �-function [Ahnert,
1970; Carson and Kirkby, 1972]. The simple transport law and regolith production function constitute the
process rules in our geomorphic model. In the simple case that production rate decreases with increasing
regolith thickness, production at a given depth is described by the surface production rate, Ba, the thickness
sensitivity, Bb, and the regolith thickness, H �B (Figure 2.3c):

@B

@t
= �Bae

�Bb(H�B) (2.9)

where, Ba is the production rate of regolith when bedrock is exposed (L/T),

and Bb is the thickness sensitivity of production rates (1/L).

In this formulation, the production rate of transportable material is largest when the bedrock is exposed
and decreases as the thickness of transportable material increases. Larger surface production rates result
in faster conversion of bedrock to regolith along the entire pro�le, whereas smaller values of the thickness
sensitivity allow production rates to remain larger with depth than do large values of Bb. Measurements
using cosmogenically produced 26Al and 10Be by Heimsath et al. [1998] along study sites in the northern
Bay Area, California and Coast Ranges, Oregon, indicate Ba = 8� 10�5 m/yr and Bb = 2 m�1.
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2.2.3 Coupled tectonic and geomorphic model

We combined these models of tectonic deformation, geomorphic transport, and production of regolith from
bedrock to understand the in
uence of various processes and rates on the morphologic development of scarps.
We reduced our geomorphic transport and tectonic models to a one-dimensional system by assuming that
all transport takes place along a cross-section (i.e., there is no out of plane movement of material). This
represents an in�nitely long scarp perpendicular to the geomorphic transport direction. While the tectonic
displacement rates may be computed directly, we solved the geomorphic transport and regolith production
equations by �nite di�erences [e.g., Ferziger, 1981]. In this numerical method, the solution domain is divided
into regularly spaced elements. Elevation pro�les are numerically di�erentiated twice in space and integrated
once in time to compute the change in the pro�le over a certain time increment, �t, using prescribed
boundary conditions. With each successive time step, we add the appropriate tectonic displacements and
produce additional regolith according to our tectonic and regolith production laws. In the model, the fault
may slip in discrete events or continuously. If the fault slips discretely, displacements resulting from the
characteristic fault slip are added to the pro�le length (x) and elevation values (H) when the model time
since the last rupture exceeds the recurrence time of the fault. In the case of a continuously slipping fault,
displacements are added during each time step of the model. We reinterpolate the surface elevations at
each successive time step and allow node overlap of the bedrock pro�le to simulate faulting of bedrock
against regolith. We used a second and �rst order di�erentiation and integration method, respectively, to
solve the discrete partial di�erential equations. To ensure numerical stability and accuracy of the solution,
we used time-steps two orders of magnitude lower than those required by the one-dimensional di�usive
stability criterion (�t = 0:01 � @x2=2�). In all of our models, we assume an initially 
at topography and
bedrock/regolith interface at t = 0. In order to accommodate production-limited conditions, we adjusted the
downslope 
ux where bedrock was exposed according to the thickness of available transportable material.
The adjusted elevation change is then added to the pro�le elevation for each successive time step until the
end of the model duration. In all transport-limited models, constant elevation boundary conditions far from
the fault are used where induced displacements are e�ectively zero. In our production-limited models, we
allowed the left and right boundaries to change their elevations as they are displaced by fault movement.
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Chapter 3

Solution by Finite Di�erence Method
(FDM)

3.1 Introduction

Intuition about the relationship between tectonic and geomorphic processes and the resulting topography
may be built by combining detailed �eld observations with careful theoretical analysis. While detailed
observations are commonly the cornerstone of sound geologic studies, theoretical modelling of the processes
involved that produce the observations is often impaired by the inability to solve the governing equations
of these processes for typical geologic conditions. However, numerical methods may be employed that let us
approximate the governing di�erential equations for a wide range of geologically applicable scenarios.

This section describes and illustrates a simple implementation of the Finite Di�erence Method (FDM)
for investigating the development of hillslope topography. Using this numerical technique, we show how
simple ideas about the transport of geomorphic material, production of regolith from bedrock, and relative
tectonic displacements may be used to extrapolate limited observations of topography at a particular time
to approximations of how the topography might have looked in the past and future. In addition, conceptual
models, cast in the language of mathematics, allow us to link observations that typically do not directly tell
us about the underlying processes to the processes themselves. This portion of the document is modi�ed
from Arrowsmith [1995].

3.2 Di�usive Hillslope Transport

3.2.1 Review of basic derivation

We use for our example of the �nite di�erence method a hillslope whose transport is governed only by
the local slope and some transport constant and for which conditions are transport-limited. This situation
is described in a previous section, and results in the following governing di�erential equation for material
transport:

Q(x) = ��@H
@x

(3.1)

Where x is the location of each point along the pro�le, H is the elevation at that point, � is the hillslope
di�usivity, and Q(x) is the 
ux of material at each point.

15
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Figure 3.1: The geometry of a simple initially vertical fault scarp and its subsequent degradation with time.
Dashed line is the initially vertical pro�le, the initial o�set (2a) is 2 m, and b = 5�.

In addition, if the density of sediment remains constant through transport, any change in 
ux must be
compensated by either 1) the addition or removal of material at each point, or 2) a change in the elevation.
This mass balance can be expressed in the form of the continuity equation:

@H

@t
= �@Q

@x
(3.2)

These two equations constitute the constitutive equations of di�usive hillslope erosion. Substitute the trans-
port rule (3.1 for Q(x) into the continuity equation (3.2) to get the homogeneous linear di�usion equation
in which the change in elevation with time is proportional to the local curvature of the topographic pro�le:

@H

@t
= �

@2H

@x2
(3.3)

3.3 is analogous to the heat conduction equation for one dimensional heat transport in which � would be
the coe�cient of proportionality called the thermal conductivity and H would be temperature [e.g., Avouac,
1993; Hanks et al., 1984; Nash, 1980].

3.2.2 Analytical solutions to the di�usion equation{Vertical scarp initial con-
ditions

First, we will illustrate the analytic solutions to the simple di�usion equation (an approach presented in
Hanks et al. [1984]). A solution of the homogeneous linear di�usion equation (3.3) for a step of topography
of 2a at t = 0 and x = 0 (e.g., a newly formed fault scarp, and note that the origin for x in this example is
in the mid scarp and not at the upper boundary) on a pre-existing topographic slope of b is

H(x; t) = a erf

�
x

2
p
kt

�
+ bx (3.4)

The resulting pro�les are not uniquely dependent on t or �, but rather their product. For example, the same
pro�le will result for � = 1 m2=kyr and t = 10 kyr or � = 10 m2=kyr and t = 1 kyr. [T. C. Hanks personal
communication and Hanks et al., 1984]. For this presentation, we have separated these values to emphasize
the fact that a known value for � or t may be used to constrain the other. Figure 3.1 shows the geometry
of this simple fault scarp and a graphical solution to 3.4 for a step of 2 m at time zero and a far �eld or fan
slope of 5�, and its subsequent degradation with time.

3.2.3 Analytical solutions to the di�usion equation{Finite slope scarp initial
conditions

Equation 3.4 provided a solution of the di�usion equation (3.3) for an in�nite slope (vertical) initial scarp
slope (Figure 3.1). Clearly, a vertical scarp will not last long, nor will "di�usive" processes operate on such
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Figure 3.2: The geometry of a �nite initial slope fault scarp and its subsequent degradation with time.
Dashed line is the initial pro�le (initial scarp slope of 45�), the initial o�set (2a) is 2 m, and b = 5�.

steep slopes. Therefore, it is important to develop the analysis for �nite initial slope scarps. Hanks and
Andrews (1989) provided the following equation for the same conditions that give rise to 3.4, except that
the fault "occurs" on a slope of � instead of 1. The solution to 3.3 is:

(3.5)

H(x; t) = (� � b)

�
�t

�

�1=2�
exp

�
�x+ a=(� � b)

4�t

�
� exp

�
�x� a=(� � b)

4�t

��

+
� � b

2

��
x+

a

� � b

�
erf

�
x+ a=(� � b)

(4�t)1=2

�
�
�
x� a

� � b

�
erf

�
x� a=(� � b)

(4�t)1=2

��

+bx

Figure 3.2 shows the geometry of this simple fault scarp and a graphical solution to 3.5 for a step of 2
m at time zero and a far �eld or fan slope of 5�, and a �nite initial scarp slope of 45�, and its subsequent
degradation with time.

The MATLAB codes for solving these equations are available at
http://activetectonics.la.asu.edu/diffuse/

For some speci�c initial and boundary conditions, analytic solutions such as those presented in this and
the last section may be solved [e.g., Carslaw and Jaeger, 1959 and see Hanks, 2000 and references therein].
However, in many geologic environments, initial pro�les may be complicated. Also, tectonic displacements
will not be uniform, as points near the fault ends will have di�erent displacements than their counterpoints
located far from these ends. Finally, fault slip rates may vary with time and geomorphic transport may
be subject to certain constraints, such as the lack of transportable material once bedrock is exposed. For
this reason, 
exible numerical solutions to these di�erential equations are necessary if we are to apply the
principles of this simple transport process to a wide range of realistic geologic conditions.

3.3 Finite di�erence approximation

3.3.1 Taylor series and approximations of the �rst derivative

The �nite di�erence method is based on the idea that derivatives and integrals of functions can be approx-
imated by calculating discrete values of the equations when the di�erentiation or integration step is small.
For example, in the di�erence quotient, which relates a function to its derivative, we approximate the limit
of dx ! 0 by letting dx equal some arbitrarily small number. To do this, we �rst divide the solution space
into discrete elements, separated by a uniform, but small distance, �x. Each point (or node) in this space
has a corresponding value of the function. In our example, we consider the location of the nodes to represent
the distance along a topographic pro�le and their values to represent the elevation at a each location. If we
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need to compute the derivative (or slope) of the topography, we can use the Taylor Series approximation of
a function at a point [Chapra and Canale, 1988; Ferziger , 1981]:

f(xi+1) = f(xi) + f 0(xi)(xi+1 � xi) + f 00
xi
2!
(xi+1 � xi)

2

+f 000
xi
3!
(xi+1 � xi)

3 + � � �+ fn
xi
n!
(xi+1 � xi)

n +Rn (3.6)

where Rn is a remainder term for terms n+1 to 1, and f 0(xi) is the �rst derivative at xi, etc. If we assume
that the terms to the right of the �rst derivative that we are trying to compute (f 0) yield an answer that is
small, we can truncate the remaining terms and solve for the value of the derivative:

f(xi+1) = f(xi) + f 0(xi)(xi+1 � xi) +R1

f 0(xi) =
f(xi+1)� f(xi)

xi+1 � xi
� R1

xi+1 � xi
(3.7)

(1st order approximation� truncation error)

Then let �x = (xi+1 � xi) [step size], and �f = f(xi+1)� f(xi) [�rst forward di�erence], so that the �nite
divided di�erence is

f 0(xi) =
�f

�x
� 0

�x
(3.8)

In the �nite di�erence approach, we assume that the space step is uniform in the model space. Therefore,
the denominator of 3.7 is equal to the uniform spacing (�x). Importantly, in the above example, we have
truncated the trailing terms in the Taylor series approximation, assuming that they are small relative to the
value of the derivative we computed. This is conceptually the simplest way to compute a �nite di�erence,
but is de�nitely not the most accurate. Because only the �rst term of the Taylor Series was kept in our
approximation, we term this method "�rst-order accurate." Generally, we desire methods that are more
accurate than this for our approximations.

In the above derivation, we computed the derivative of the function by using the point located one step
beyond the point at which the derivative was calculated. We could have just as easily elected to compute
the derivative based on the previous point, located one step behind the point at which we wish to calculate
the derivative. The preceding derivation is called the forward �nite di�erence because it computes the
derivative based on the point ahead of the point of the derivative, and the latter case is called the backward
�nite di�erence. It is computed in a similar way as the forward �nite di�erence:

f(xi�1) = f(xi)� f 0(xi)�x+ f 00
�x2

2!
� : : : (3.9)

By subtracting these two approximations, a far more accurate approximation (called the centered �nite
di�erence) of the derivative can be made:

f(xi+1) = f(xi�1) + 2f 0(xi)�x+ f 000
�x3

3!
+ : : :

f 0(xi) =
f(xi+1)� f(xi�1)

2�x
� f 000(xi)

6
�x2

f 0(xi) =
f(xi+1)� f(xi�1)

2�x
� 0�x2 (3.10)

Equation 3.10 is the centered or central di�erence representation of the �rst derivative. Notice that it is
second order accurate (we truncate after the second derivative). Figure 3.3 shows the geometry of these �rst
derivative approximations.
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Backward difference

Figure 3.3: Graphical representation of various di�erence approximations of the slope (1st derivative; f 0(xi))
of a function and their relation to the true slope at that point. Note the increased accuracy of the centered
di�erence.

3.3.2 Finite di�erence approximations of higher order derivatives

First, write a forward Taylor Series approximation of f(xi+2) in terms of f(xi):

f(xi+2) = f(xi) + f 0(xi)(2�x) + f 00
xi
2!
2�x2 + : : : (3.11)

Multiply 3.8 by 2 and subtract from 3.11 to yield

f(xi+2)� 2f(xi+1) = �f(xi) + f 00
xi
2!
2�x2 + : : : (3.12)

Which is solved for

f 00(xi) =
f(xi+2)� 2f(xi+1) + f(xi)

�x2
� 0

�x
(3.13)

That relationship is called the second forward �nite divided di�erence. Similar manipulations can be employed
to derive a backward version

f 00(xi) =
f(xi)� 2f(xi�1) + f(xi�2)

�x2
� 0

�x
(3.14)

and a centered version

f 00(xi) =
f(xi+1)� 2f(xi) + f(xi�1)

�x2
� 0

�x2
(3.15)
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As was the case with the 1st order approximations, the centered version is more accurate. Also notice that
the centered version can alternatively be expressed as

f 00(xi) =
f(xi+1)�f(xi)

�x � f(xi)�f(xi�1)
�x

�x
� 0

�x2
(3.16)

Thus, just as the second derivative is the derivative of a derivative, the second divided di�erence approxi-
mation is a di�erence of two �rst divided di�erences.

3.4 Numerical solutions to the basic linear di�usion erosion prob-

lem

3.4.1 Derivation

Here we present an explicit �nite di�erence method for solving equation 3.3 for arbitrary initial conditions (see
Figure 3.4 for the temporal and spatial discretization grid and computational molecule). First, approximate
the time derivative (left hand side of 3.3) with a forward divided di�erence 3.8:

@H

@t
� H l+1

i �H l
i

�t
(3.17)

Note that we introduce the space index i (subscripted) and the time index l (superscripted). We assume
no tectonic input and transport-limited conditions. Secondly, approximate the space derivative (right hand
side of 3.3) by a centered divided di�erence 3.15:

@2H

@x2
� �

H l
i+1 � 2H l

i +H l
i�1

�x2
(3.18)

substitute 3.17 and 3.18 into 3.3 to yield the explicit �nite di�erence approximation of the elevation at H l+1
i

as a function of its neighbor points at H l
i . It provides an explicit means of computing values at each node

H

x

l

l+1

i-1 i i+1

A B

∆t

∆x

{

{

Figure 3.4: A) Discretized pro�le. Interior nodes are solid and their changes in elevation with time can
be solved with the method described here, whereas the boundary node (open) elevations must always be
speci�ed. B) Computational molecule for three adjacent nodes within the pro�le (for example those boxed
at left). Note how the elevation of the central point (i) in the future (l+1) is a function of its elevation and
that of its immediate neighbors at time l.
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Figure 3.5: A) Comparison between analytical (solid line) and numerical (+) solutions to the di�usion
erosion of the initial pro�le (dashed line) for �t = 5 m2. B) Di�erence between analytical and numerical
solutions. Errors are acceptably small and in the interior result from numerical inaccuracy and on the edges
from the di�erence in boundary conditions (constant elevation for numerical method and elevation change
for analytical method).

for a future time, based on the present values.

H l+1
i �H l

i

�t
= �

H l
i+1 � 2H l

i +H l
i�1

�x2

H l+1
i = H l

i +
��t

�x2
�
H l
i+1 � 2H l

i +H l
i�1

�
H l+1
i = H l

i + �
�
H l
i+1 � 2H l

i +H l
i�1

�
(3.19)

where � = ��t
�x2 . This equation is written for all interior nodes of the pro�le (Figure 3.4). This explicit

method is convergent and stable for � � 1=2, or �t � 1
2
�x2

� (Ferziger, 1981).

3.4.2 Benchmarking the method{how accurate is it?

Whenever one uses an approximate method such as the FDM discussed here, it is appropriate to check
its accuracy by comparing numerical results with those calculated analytically. Such a calculation has to
be done within the stricter conditions of the analytical solution, but it lends con�dence to the subsequent
broader application of the numerical solutions.

As an illustration of the accuracy and behavior of the numerical method employed above, we "bench-
marked" it against the �nite slope analytical solution (3.5) for a morphologic age of �t = 5 m2 (Figure 3.5).
In that �gure, the upper panel shows that the two methods are graphically similar and that the error is
small. The lower panel shows the di�erence between the analytical and numerical solutions and illustrates
two important points: 1) The lower magnitude errors that are antisymmetric about the origin are due to
the numerical inaccuracy. They correlate with the curvature of the model. 2) The larger magnitude errors
at the end of the pro�le are the result of a di�erence between the boundary conditions of the numerical
model (constant elevation) and the elevation change calculated analytically. The analytical model indicates
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Figure 3.6: Example Microsoft Excel Spreadsheet for explicit �nite di�erence. The values inside the bold
boxes can be changed and the result plotted in a chart. Figure 3.7 shows the equivalent spreadsheet with
the formulae displayed.

that a morphologic age of 5 m2, elevation change (erosion and deposition) has reached the edges of the
solution domain (-10 and 10 m). However, the numerical model �xes those boundary elevations and thus
the two solutions diverge. To address this problem, the easiest thing to do is extend the numerical method
boundaries far beyond the domain of interest (and increase the number of nodes if the same level of detail
in the approximation is desired).

3.4.3 An example application of the 1-D explicit �nite di�erence method solved
using a spreadsheet (Microsoft Excel)

In Figures 3.6, 3.7, and 3.8, we illustrate how one might solve the di�usion erosion problem using a spread-
sheet. Figure 3.6 is an example spreadsheet used to solve 3.3 by 3.19. The constants in solid boxes are input,
and the spreadsheet determines the rest. Figure 3.7 shows the necessary Microsoft Excel formulae. In order
to calculate to a given age, we must copy the D column to the right enough times to keep the calculation
stable. For example, to determine the pro�le shown in Figure 3.8A, 100 time steps, or 100 columns were
used. For the given parameters such a result is well within the stability criterion (unlike Figure 3.8B; a nice
example of an unstable solution). These examples are limited in number of nodes for convenience. Simple
explorations with this tool can be very useful to build intuition about this geomorphic process, the impor-
tance of initial and boundary conditions, and the uniqueness of the morphologic age (�t) for form. More
elaborate spreadsheets and simple exercises are available at
http://www.public.asu.edu/�arrows/geomorph/diffuse/index.html.
A MATLAB implementation of this method is available at
http://activetectonics.la.asu.edu/diffuse/
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Figure 3.7: Example Microsoft Excel Spreadsheet for explicit �nite di�erence with formulae shown.
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Figure 3.8: Microsoft Excel plots showing the initial and �nal pro�les determined using the sample spread-
sheet (Figures 3.6 and 3.7). A) Di�usion erosion solution for degraded step; 1-D explicit �nite di�erence
technique, t = 5 kyr, � = 1m2=kyr. B) Unstable di�usion erosion solution for degraded step; 1-D explicit
�nite di�erence technique, t = 1000 kyr, � = 1m2=kyr (with a large � = 0:625; exceeding the stability
criterion).



Chapter 4

How to use the software

4.1 Introduction

In this chapter, we describe how a practioner may use the Penck1Dmodel to simulate fault scarp development.
We created a Graphical User Interface (GUI) to the �nite di�erence code that aids in the creation, display,
and analysis of the fault scarp models. In particular, we have created a variety of functions that allow location
(X), topography (Z), and bedrock elevation (B) to be imported into the software and interpolated to form
the initial conditions of the model. Easy entry of model parameters is facilitated by the interface. Also,
we provide functions to create and manipulate a number of simple initial conditions. Finally, we provide
routines that allow the initial conditions, fault geometry and displacements, and model results to be easily
plotted.

In the sections that follow, we outline the operation of the GUI and how the user can change the model
parameters for the simulation. Then, we introduce the reader to the di�erent menu functions that may be
used to import or export data, manipulate imported data, set initial conditions, run models, and plot the
results. Finally, we give a series of examples that will help illustrate the practical operation of the program.

4.2 Using the program

4.2.1 A note about units

Penck1D does not use a speci�c set of units. Therefore, the choice of the units is up to the user. However,
it is important to use consistent units for each of the model parameters. The default settings correspond to
an example set of values in the following units: [L]ength units, meters; and [t]ime units, years. When using
di�erent units, make sure to convert all values into the same units before running a model.

4.2.2 Starting the program

Penck1D uses built-in routines of the MATLAB software, available from the MathWorks. Make sure to
properly install this software before trying to use the Penck1D program.

In order to use Penck1D, launch Matlab, and then type \penckgui" at the prompt:

>> penckgui

This will start the Penck1D interface.

25
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4.2.3 General model building procedure

Building a scarp model consists of the following steps:

1. Set model parameters. Values specifying the fault geometry and rates, geomorphic transport rates,
and bedrock production rates must be speci�ed. Do this by modifying the default example values that
are speci�ed when the program is started.

2. Import and grid X, (B), H data. Data may be read from a text input �le that speci�es the initial
topography (H) and bedrock elevation (B) for the model. Once the data are imported, they may be
interpolated to form a pro�le that is appropriate for the model.

3. Set initial conditions. Gridded input data may be applied to the initial conditions of the model
(topography and bedrock elevation), or simple initial geometries may be speci�ed. Examples of these
simple initial geometries are 
at and sloping surfaces.

4. Run model. Either transport- or production-limited models may be run. If production-limited
conditions are not expected to be important, run a transport-limited model for computational e�ciency.

5. Plot results. Initial conditions, fault geometry, fault displacements, and time snapshots of fault
development may be plotted.

6. Save or export data. Model results may be saved for future viewing or exported as X, (B), H text
�les that can be read by a variety of common plotting packages, such as Microsoft Excel.

4.2.4 Setting model parameters

The �rst step in building a model is specifying the rates of movement along and geometry of the fault. In
addition, geomorphic transport rates, regolith production rates, and boundary conditions at the left and
right sides of the pro�le must be speci�ed. All of these model parameters may be set in the Penck1D main
window.

In Figure 4.1, we have labeled each of the areas that correspond to the values. The labels, parameter,
and dimensions of each of the model parameters are outlined in Table 4.1. To change each of the model
values, use the cursor to select the value, and change it as appropriate. Values will not be modi�ed if they
contain invalid information (e.g., value out of parameter range or letters in a numeric entry).
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Figure 4.1: Main screen (with labeled parameters) for Penck1D software. See Table 4.1 for meaning, units,
and common values of model parameters.
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Table 4.1: Model Parameters and typical values. Numbers refer to Figure 4.1

# Symbol Parameter Dimensions Default Value
1 dx Model Spacing [L] 1 m
2 nx Number of Points in Model N/A 1001
3 t(output) Time at which output is recorded [t] 1, 10, 100, 1000, 10000 yr
4 Xo Left hand location of pro�le [L] -500 m
5 dt Time step [t] 62.5 yr
5a N/A Maximum stable dt button N/A N/A
6 LBCTYPE Left side boundary condition type N/A Constant Elevation
7 LBC Left side boundary condition value * 0
8 RBCTYPE Right side boundary condition type N/A Constant Elevation
9 RBC Right side boundary condition value * 0
10 Fault Type Sense of slip on fault N/A Normal Fault
11 Fxo X-coordinate of upper fault tip [L] 0 m
12 Fzo Z-coordinate of upper fault tip [L] 0 m
13 L Fault Length [L] 5000 m
14 b Fault Slip Rate [L/t] 0.001 m/yr
15 � Fault Dip [�] 60�

16 � Hillslope di�usivity [L2/t] 0.004 m2/yr
17 Ba Surface Regolith Production Rate [L/t] 8� 10�5 m/yr
18 Bb Regolith Production Depth Scaling Factor [1/L] 0.1 m�1

* denotes parameters whose dimension varies according to boundary condition type. Boundary condition
types \Constant Elevation" and \Constant Flux" produce dimensions of [L] and [L2/t], respectively.

The t (output) entry (3) speci�es the times at which model output is desired. This may be entered as a
comma-delimited list of numbers. For example, if output is desired at times of 10, 30, 40, and 1000, highlight
the values in the t (output) box and type 10, 30, 40, 1000.

TheMaximum stable t-step button (5a) resets the value of the time step, dt (5) to its maximum allowable
value. In the case that a smaller dx is entered, the value of dt is adjusted to maintain stability. If a larger
value of dx is entered, the value of dt is not adjusted because it is allowable to have time steps smaller than
the stability criterion but not larger. Pressing the Maximum stable t-step button ensures that the time step
is appropriate for the value of � and dt being used.

Note: The criterion for stability in a one dimensional di�usive model is �t = 0:5 � dx2=�. However, we
allow a maximum time step of �t = 0:1� dx2=� to maintain some degree of accuracy in the solution.

The types of boundary conditions prescribed at the model edges may be changed using the pull-down
menus shown in Figure 4.2. The left and right boundary conditions may be changed using the (6) and (8)
pulldown menus, respectively.

Figure 4.2: Popup used to change boundary conditions. Click and hold on (6) or (8), and drag the menu to
select the appropriate boundary condition type.
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4.2.5 Menu functions

File menu

Basic functions for reading and writing �les are found in the File Menu (Figure 4.3). The New function
(FM1) clears all variables to their default values, erases any imported data, and deletes the current model
results. When this option is selected, a dialogue box (Figure 4.4) is displayed to make sure that all model
variables should be cleared. Open... (FM2) is used to load a previously saved Penck1D session that was
saved using the Save As... function (FM3). The Save As... function saves any current model results and
all model parameters, imported data, and gridded data in a Matlab .mat �le that can be read into Matlab
for later use. All of these functions initiate a dialogue that requires the name of the �le to be opened or
saved to be selected or typed.

FM1
FM2
FM3
FM4
FM5
FM6

Figure 4.3: File menu for Penck1D.

Figure 4.4: Dialogue box to con�rm all variables should be cleared.

Data can be imported and exported as text �les using the Import (FM4) and Export (FM5) submenus.
Exported �les can be read into spreadsheet or plotting programs such as Microsoft Excel and imported �les
may be used to import complex initial pro�le geometries into Penck1D. The Import and Export menus are
shown in Figures 4.5 and 4.6, respectively.

FM4a
FM4b
FM4c

Figure 4.5: Import submenu for Penck1D.

Three di�erent types of �les may be imported and used as initial conditions in a Penck1D model. First,
a �le containing location and elevation points (X-H data) may be imported using Import X-Z data...

(FM4a). Each point consists of an X and H value separated by spaces or tabs. Each line of the �le should
contain one corresponding X-H pair. For example, if the three measured coordinates of (�5; 1), (0; 0), and
(5; 3) are to be imported, the �le should look like:
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-5 1

0 0

5 3

In addition, if a measured or complicated initial bedrock pro�le is to be imported, use Import X-B

data... (FM4b). The input text �le should have identical syntax as the previous example, except that the
elevation values should be replaced by the bedrock elevation values.

If values of topographic and bedrock elevation are recorded for identical points, use the Import X-Z-B

data... (FM4c) to use these data for the initial pro�le and bedrock conditions. The �le syntax is similar to
the above two examples, except that each point contains three values and so must have the location, pro�le
elevation, and bedrock elevation values in each line. For example, if the (X;Z;B) values that you wish to
import are (�5; 4; 2), (0; 5; 1), and (5; 2;�5) the input �le should have the following syntax:

-5 4 2

0 5 1

5 2 -5

In addition, model results and parameters can be saved to a text �le that can then be used in other plotting
and analysis programs. Figure 4.6 shows the export options that are available in Penck1D. Importantly,
exported �les cannot be directly read back into Penck1D using the Open... (FM2) or Import submenu
(FM4) functions. In order to save all parameters and model results in a format recoverable by Penck1D, use
the Save As... command (FM3).

FM5a
FM5b
FM5c
FM5d

Figure 4.6: Export submenu for Penck1D.

Several di�erent types of data can be exported from Penck1D. First, the model parameters can be
exported into a �le for later reference using the Export Model Parameters... function (FM5a). Second, the
location and elevation data from the model results may be exported using the Export X-Z data... (FM5b)
command. Third, if the bedrock elevation is desired, use the Export X-B data... (FM5c) command.
Finally, if all of the model results should be exported into a text �le, use the Export X-Z-B data...

(FM5d) command. Importantly, exporting any model elevation results(FM5b{d) will also export the model
parameters at the beginning of the �le.

If the type of output chosen is elevation data (FM5b{d), the times at which the data should be output
must be selected. For example, if model results were collected at t (output) = 1,10,1000,10000,100000,
and you wish to write out only 10000 and 100000, you must select these times in the following manner.
After selecting the type of data you wish to export, you will be confronted with the dialogue box shown in
Figure 4.7. To select the proper times, click on 10000 and 100000 (solid arrows) to select the desired model
times. Next, click on 0 (open white arrow) to unselect 0 as an output model time. Next, click Continue and
you will be presented with a dialogue box that allows speci�cation of the output �le name.

Finally, to quit Penck1D, select the Quit option from the File menu (FM6). This presents the dialogue
box shown in Figure 4.8, con�rming that you wish to quit Penck1D.
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Figure 4.7: Dialogue box to select times to export model topography to text �le.

Figure 4.8: Dialogue box con�rming exit from Penck1D.

Edit menu

The Edit menu (Figure 4.9) allows manipulation of imported data. When (x;H), (x;B), or (x;H;B) data
is imported into the program, it must be interpolated to contain surface and/or bedrock elevation values at
each model location de�ned by Xo, dx, and nx. After interpolation of the imported data has been performed,
the original imported data is kept in the event that the Xo, dx, or nx values are changed. If these values
are changed, the imported data must be reinterpolated to accommodate the new model pro�le parameters.
Functions in the Edit menu provide tools with which to modify the imported data and interpolate (grid)
these data into a surface or bedrock pro�le that can be applied to the initial conditions using the Initial

Conditions menu.

The �rst function in the Editmenu allows exchange of the imported bedrock elevations (Bedrock) and sur-
face elevations (Pro�le) data. For example, if data imported as Pro�le data should be used as the bedrock el-
evations, switch the two using the Switch Import Data (bedrock->profile, profile->bedrock) (EM1).

EM1
EM2

Figure 4.9: Edit menu for Penck1D.

Once data has been imported and properly stored in Penck1D, it must be interpolated into a pro�le for
which there are elevation values at regularly spaced points. This spacing is de�ned by the dz parameter.
To perform this interpolation, use the Sort and Grid Import Data submenu (EM2). Here, select Profile
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Import Data (EM2a) or Bedrock Import Data (EM2b) if you would like to grid the surface and bedrock
elevation data, respectively, imported using the Import submenu (FM4) of the File menu.

Note: Each time the model parameters that de�ne the spacing, location, and length of the pro�le are
changed, the imported data must be regridded. Failure to do so will result in an error.

Note: It is possible to use imported pro�le points that do not span the full model space de�ned by the
Xo, dx, and nx values. This results in a lack of data with which to interpolate the pro�le and/or bedrock
values at one or both of the two ends of the model. If this situation arises, Penck1D automatically assumes
that the extreme locations of the model have the elevation of the nearest imported point.

EM2a
EM2b

Figure 4.10: Sort and Grid submenu for Penck1D.

Initial conditions menu

The Initial Conditions menu is used to set the initial pro�le and bedrock geometry of the model. This
geometry can be a simple, theoretical geometry, or one that is measured or inferred in the �eld and imported
into the model using the Import (FM4) and Sort and Grid Import Data (EM2) submenus discussed pre-
viously.

ICM1
ICM2
ICM3
ICM4
ICM5
ICM6
ICM7
ICM8
ICM9

ICM10
ICM11

Figure 4.11: Initial conditions menu for Penck1D.

Simple initial topographies may be speci�ed using the �rst two functions in the Initial Conditions

menu. The Flat Initial Topography at z=0 (ICM1) sets the pro�le (surface) surface elevation values to
zero at the spacing, location, and length speci�ed by Xo, nx, and dx. Importantly, the bedrock elevations
are not a�ected by this function. In addition, sloping initial surfaces may be speci�ed using the Sloping

initial profile... (ICM2) function. A dialogue box then appears (Figure 4.12 that requests the angle
of the sloping surface. In our model, negative and positive angles specify surfaces that slope to the right and
left, respectively. Again, the bedrock elevation is una�ected by this function.

To apply imported and previously gridded data to the pro�le (surface) or bedrock elevation initial condi-
tions, use the Apply Gridded Profile Data to Initial Condition (Topography) and Apply Gridded

Bedrock Data to Initial Conditions (Bedrock) functions. These copy the pro�le and bedrock
data gridded by the Sort and Grid Import Data > Profile Import Data (EM2a) and Sort and Grid

Import Data > Bedrock Import Data (EM2b), respectively, to the speci�ed initial condition.

In addition, pro�les produced as model results may be applied as initial conditions. The next four
functions (ICM5{8) apply the last calculated and recorded model pro�le and bedrock values to the initial
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Figure 4.12: Dialogue box requesting input for a sloping surface initial condition.

conditions of a new model. (ICM5) applies the �nal pro�le model results to the topography initial condition,
(ICM6) applies the �nal bedrock model pro�le to the bedrock initial condition, (ICM7) applies the �nal
elevation values to the bedrock initial condition, and (ICM8) applies the �nal bedrock values to the pro�le
initial condition.

The surface or bedrock pro�les may be o�set by a uniform elevation using the Offset Profile...

(ICM9) and Offset Bedrock... (ICM10) functions, respectively. These functions trigger a dialogue box
that requests the input of a uniform o�set for the pro�le (ICM9; Figure 4.13) or bedrock (ICM10). For
example, if one wished to text a uniform decrease in regolith thickness on a model whose initial conditions
were imported from a text �le, the bedrock elevation could be increased the amount that corresponded to
the decrease in regolith thickness. Finally, the initial conditions speci�ed for the surface elevations may be
copied to the bedrock elevations using the Copy Profile to Bedrock (ICM11) command. This command is
especially useful for constructing simple initial conditions in which the bedrock elevations parallel the surface
elevations. By copying the pro�le elevations to the bedrock elevations using (ICM11) and then o�setting
the bedrock by a uniform thickness equal to the initial regolith thickness (ICM10), a situation in which a
uniform-regolith landscape can be constructed.

Figure 4.13: Dialogue box requesting a uniform o�set for surface elevation (Pro�le) data.

Plot menu

The Plot menu is used to display di�erent aspects of the model including initial conditions, fault geometry,
fault displacements, and the coupled geomorphic and tectonic model results. Figure 4.14 shows the di�erent
items in the menu. In addition, any plots can be saved, printed, or exported to di�erent �le formats (such as
Encapsulated Postscript or Adobe Illustrator formats) for direct inclusions in reports or research documents.

PM1
PM2
PM3
PM4

Figure 4.14: Plot menu for Penck1D.

The model initial conditions can be displayed by selecting the Initial Conditions : : : option (PM1) in
the Plot menu. If the initial conditions are properly assigned, a window similar to that shown in Figure 4.15
opens, displaying the initial conditions. In this plot, the surface, bedrock/regolith interface, and bedrock
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are shown with a solid line, dashed line, and gray shading, respectively. This window is a good place to
make sure that the initial conditions you desire are in fact those used in the current model. To zoom in on a
particular part of the �gure, use the magnifying glass tool on the toolbar or select Zoom from the Tools menu
of this window. Finally, the window can be printed, saved to a Matlab �gure �le, or exported to variety of
�le formats (including EPS, Adobe Illustrator, TIFF, and JPEG) using the functions in the File menu of
this window. See the Matlab command reference for more details on printing, saving, or exporting �gures.

Figure 4.15: Window displaying initial conditions and fault geometry for the current model.

To display the fault displacements that result from fault slip in the model, use the Fault Displacements

: : : option (PM2) in the Plot menu. This function calculates the displacements due to movement along
the fault during one increment of time (slip rate �t). An example of this display is shown in Figure 4.16.
There are four major parts to this �gure: 1) the upper-left frame shows the schematic fault geometry and
location of the pro�le plotted relative to the fault length. The second and third graphs (full width) show
the magnitude of the horizontal and vertical surface displacements, respectively due to fault slip. Finally,
the lowermost graph shows a vector diagram of the two displacement components along the surface pro�le.
The length of each vector is scaled to the magnitude of the displacement, with the scale shown in the upper
right hand portion of the graph.

Both the fault geometry and initial conditions can be displayed using the Fault Geometry and Initial

Conditions : : : selection (PM3). An example of the plot created using this command is shown in Fig-
ure 4.17. As with all of the plotting functions, the graphs may be rescaled, saved, printed, and/or exported
using the various functions in the Tools and File menus of the plot's window.

Finally, once a model has been run, the results may be viewed with the Model Results : : : function
(PM4). Selecting this function displays the �gure shown in Figure 4.18. As with all of the other plots, zoom
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Figure 4.16: Plot of displacements and fault geometry for current model settings. Upper right �gure shows
fault geometry, upper graph shows horizontal displacements, middle graph shows vertical displacements, and
bottom graph shows vector plot of displacements.

functions may be used to view details of the pro�les. In addition, the No Vertical Exaggeration button
removes all exaggeration in the �gure, allowing the viewer to see the true geometry of the degraded scarp
and bedrock elevation.

To view di�erent pro�les recorded at times t(output), use the t = pulldown menu shown in Figure 4.19.
For instance, the view the pro�le at the �nal time (t = 10000), click on the pulldown menu, drag to 10000,
and select this item. The model results at this time will then be displayed in the �gure.

Run menu

The Run menu is used to run the scarp simulation for the model parameters and initial conditions spec-
i�ed (Figure 4.20). One can run a transport limited or production limited model by selecting the Run

Transport Limited Model (RM1) and Run Production Limited Model (RM2), respectively. Usually, if
only transport-limited conditions exist, using (RM1) increases the computational performance slightly.

Once a model is started, a dialogue box will appear that shows the progress of the model (Figure 4.21).
Once the model has successfully �nished, a dialogue box will appear to alert the user of this (Figure 4.22).

4.3 Examples of fault scarp simulation

The following examples are intended to familiarize the reader with some of the steps required to run a
Penck1D model, view the results, and export the data. The examples are meant to be used as exercised to
increase the pro�ciency of the use of the program. The examples only contain production limited conditions;
however, transport limited models may be developed and run in a similar manner as the examples.

4.3.1 Example 1: Flat initial topography o�set by reverse faulting

In this example, we run and display the morphologic development of a scarp with moderate transport rates
(0.004 m2/yr), regolith production rates typical for the Bay Area of California (80 m/Myr), with a depth
scaling factor of (0.01 cm�1, a 10 km long (downdip length) 45� dipping normal fault that slips at 10 mm/yr,
with a 
at initial surface topography with a uniform regolith mantle of 40 cm. In the example, we model
the scarp pro�le from �500 m to +500 m. For simplicity, we do not allow regolith transport in or out of
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Figure 4.17: Plot of the fault geometry and initial conditions of the current model. This plot is useful for
making sure that the desired initial conditions and fault geometry are selected.

the left or right side boundaries. This results in 
ux boundary conditions equal to zero at the left and right
boundaries.

Follow the following steps to build the model:

1. Set model parameters:

� Set Xo = �500 to set the left-most model location to -500 m.

� Set dx = 1 to create a model with node spacing of 1 m.

� Set nx = 1001 so that the pro�le ends at 500 m.

� Click Maximum stable t-step button to set stable time step.

� Set boundary condition types (both left and right) to constant 
ux using the pulldown menus.

� Set fault dip to 45.

� Set fault type to Normal Fault using the Fault Type pulldown menu.

� Set fault length to 10000 (10 km = 10000 m; use consistent units).

� Set fault slip rate to 0.01 (m/yr).

� Set kappa (�) to 0.004 (m2/yr).

� Set Ba = 0:00008 (m/yr).

� Set Bb = 1 (m�1).

2. Set Initial Conditions:

� Create an initially 
at topography, by using the Flat Initial Topography at z=0 from the
Initial Conditions menu.

� Copy this 
at surface topography to the initial bedrock topography using the Copy Profile to

Bedrock function from the Initial Conditions menu.

� O�set the bedrock pro�le �0:4 m using the Offset Bedrock... from the Initial Conditions

menu.
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Figure 4.18: Model results plot. In this �gure, the initial conditions are displayed (t = 0).

3. Plot pre-model data (printing, saving, and/or exporting �gures as desired):

� Plot initial conditions using the Initial Conditions : : : function from the Plot menu.

� Plot displacements using the Displacements : : : item from the Plot menu.

� Plot initial conditions and fault geometry using the Fault Geometry and Initial Conditions

: : : from the Plot menu.

4. Run model: use Run Production Limited Model item from the Run menu.

5. Plot Results:

� View model results for di�erent simulation times using the Model Results : : : option from the
Plot menu.

� Save �gures as EPS �les for later printing and analysis using Export : : : option from the File
menu of the plot window.

6. Save Model:

� Save model using the Save As : : : option from the File menu

� Export the model results as an X;Z;B �le for the last time step, using the Export : : : submenu
of the File menu.

4.3.2 Example 2: Sloping initial topography o�set by normal faulting

This next example will use identical parameters as Example 1; however, the initial surface and bedrock
elevations will slope 10� to the right.

1. Set model parameters:

� Set Xo = �500 to set the left-most model location to -500 m.

� Set dx = 1 to create a model with node spacing of 1 m.
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Figure 4.19: Model results plot, showing time pull-down menu.

RM1
RM2

Figure 4.20: Run menu in Penck1D.

� Set nx = 1001 so that the pro�le ends at 500 m.

� Click Maximum stable t-step button to set stable time step.

� Set boundary condition types (both left and right) to constant 
ux using the pulldown menus.

� Set fault dip to 45.

� Set fault type to Normal Fault using the Fault Type pulldown menu.

� Set fault length to 10000 (10 km = 10000 m; use consistent units).

� Set fault slip rate to 0.01 (m/yr).

� Set kappa (�) to 0.004 (m2/yr).

� Set Ba = 0:00008 (m/yr).

� Set Bb = 1 (m�1).

2. Set Initial Conditions:

� Create a sloping surface topography, by using the Sloping initial surface : : : from the
Initial Conditions menu. Fill in �10 in the next dialogue box.

� Copy this sloping surface topography to the initial bedrock topography using the Copy Profile

to Bedrock function from the Initial Conditions menu.

� O�set the bedrock pro�le �0:4 m using the Offset Bedrock... from the Initial Conditions

menu.

3. Plot pre-model data (printing, saving, and/or exporting �gures as desired):

� Plot initial conditions using the Initial Conditions : : : function from the Plot menu.
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Figure 4.21: Dialogue box showing model progress.

Figure 4.22: Run menu in Penck1D.

� Plot displacements using the Displacements : : : item from the Plot menu.

� Plot initial conditions and fault geometry using the Fault Geometry and Initial Conditions

: : : from the Plot menu.

4. Run model: use Run Production Limited Model item from the Run menu.

5. Plot Results:

� View model results for di�erent simulation times using the Model Results : : : option from the
Plot menu.

� Save �gures as EPS �les for later printing and analysis using Export : : : option from the File
menu of the plot window.

6. Save Model:

� Save model using the Save As : : : option from the File menu

� Export the model results as an X;Z;B �le for the last time step, using the Export : : : submenu
of the File menu.

4.3.3 Example 3: Measured initial topography (imported data) o�set by normal
faulting

This example will use identical parameters to Example 1; however, we will use imported data to create the
initial conditions.

1. Set model parameters:

� Set Xo = �500 to set the left-most model location to -500 m.

� Set dx = 1 to create a model with node spacing of 1 m.

� Set nx = 1001 so that the pro�le ends at 500 m.

� Click Maximum stable t-step button to set stable time step.

� Set boundary condition types (both left and right) to constant 
ux using the pulldown menus.

� Set fault dip to 45.

� Set fault type to Normal Fault using the Fault Type pulldown menu.

� Set fault length to 10000 (10 km = 10000 m; use consistent units).
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� Set fault slip rate to 0.01 (m/yr).

� Set kappa (�) to 0.004 (m2/yr).

� Set Ba = 0:00008 (m/yr).

� Set Bb = 1 (m�1).

2. Set Initial Conditions:

� Import the X;Z data from the �le \sampleprof.xz" using the Import : : : submenu of the File
menu.

� Import the X;B data from the �le \samplebr.xb" using the Import : : : submenu of the File

menu.

� Grid imported X;Z data using the Sort and Grid import data submenu from the Edit menu.

� Grid imported X;B data using the Sort and Grid import data submenu from the Edit menu.

� Apply the gridded data (both Pro�le and Bedrock) to the appropriate initial condition using the
Initial Conditions menu.

3. Plot pre-model data (printing, saving, and/or exporting �gures as desired):

� Plot initial conditions using the Initial Conditions : : : function from the Plot menu.

� Plot displacements using the Displacements : : : item from the Plot menu.

� Plot initial conditions and fault geometry using the Fault Geometry and Initial Conditions

: : : from the Plot menu.

4. Run model: use Run Production Limited Model item from the Run menu.

5. Plot Results:

� View model results for di�erent simulation times using the Model Results : : : option from the
Plot menu.

� Save �gures as EPS �les for later printing and analysis using Export : : : option from the File
menu of the plot window.

6. Save Model:

� Save model using the Save As : : : option from the File menu

� Export the model results as an X;Z;B �le for the last time step, using the Export : : : submenu
of the File menu.



Chapter 5

Final Thoughts: Validity of scarp
modeling approach

The Penck1D model requires that the topography is continuous along the pro�le length and all deformation
results from elastic deformation of the crust. In nature, a �rst-order feature of faults is that they o�set
material, thus creating a discontinuity in a structural datum. For instance, su�ciently large reverse fault
o�sets in scarp models may cause adjacent nodes in the �nite-di�erence model to overlap in space. While
this is a physically reasonable condition, the solution method requires the topography to be continuous and
the node spacing to be uniform. In order to circumvent this problem, the model reinterpolates the elevation
pro�le at every time step and relocates the fault tip location to remain at its prescribed location. In reality,
a thrust plate may ride over the surface of the preexisting topography for large distances, deforming the
hangingwall at the surface into a fault bend fold [Lave and Avouac, 2000;Wesnousky et al., 1999; Arrowsmith
et al., 1999b]. These scenarios are not modeled for the following reasons: 1) We do not know the factors that
may control how far the thrust plate may ride over the surface before the reverse fault straightens itself by
propagating through the hangingwall. This leads to abandonment of the section of the plate that overrode
the land's surface; and 2) Material that is eroded o� the front of the reverse scarp may be deformed by the
advancing thrust plate or simply overridden. The controls on this process may be extremely site-speci�c.
While a more physically reasonable representation of reverse fault scarps might include these factors, further
�eld investigations that relate the rock physical properties, deformation rates, and thrust advance must be
studied in detail.

The implicit assumption of the reinterpolation and normalization that is performed is that the e�ect
of the horizontal strain is small relative to the vertical strain. Therefore, we expect our transport-limited
approach to well- and poorly- approximate the topographic pro�le of the scarp when the fault dip is high
and low, respectively. While these e�ects are ignored in this simple model, these avenues are fruitful paths
of future research in fault scarp geomorphology.

Importantly, we have chosen an extremely simple system that consists of a single tectonic, geomorphic,
and production process. Real scarps may be a�ected by many other production, transport and tectonic
processes than those modeled. For example, channels, soil slips, bedrock landslides, debris 
ows [e.g., Ritter
et al., 1995], and distributed deformation near the fault [Hilley et al., 2001] are all processes that may act
to create and modify topography around a fault. While this simple approach neglects them, it is a �rst step
towards modeling more complex tectonic and geomorphic systems to understand fault scarp development.

Previous work [Arrowsmith et al., 1996] reinterpolates the regolith/bedrock interface in the subsurface
in addition to the topography at each time step. It has been shown [Hilley et al., in review] that this type
of interpolation does not allow the physically reasonable condition of bedrock and regolith juxtaposition
in the subsurface. Reinterpolating this pro�le numerically erodes the bedrock, discouraging the onset of
production-limited conditions. This situation arises purely as a model artifact, which once removed as in
the current Penck1D model, allows fault movement to rapidly expose bedrock.

41
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